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Abstract 

This report details a project to capture time-series panoramic imagery over a two-year 
period at the A83 Rest and be Thankful site, which is highly susceptible to rainfall-induced 
debris flow. This builds on a previous proof-of-concept project and the available data is 
reported for both projects in order to present as complete a picture as possible. Imagery 
from the A85 Glen Ogle site, captured on an opportunistic basis, is also reported. The data 
has been used in a variety of ways in support of other monitoring and construction 
reporting activities at the A83 site and its use is planned in a survey to determine the hazard 
from boulders that currently reside at the A83 site. The time-series imagery provides 
effective before-and-after imagery for major events and its continued capture and use is 
recommended. This report sets out the process and procedures for the capture and creation 
of high resolution imagery in order to enable the time-series to be continued and for the 
methodology to be applied to other sites. 
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1 Introduction 

The south-west facing slopes of Beinn Luibhean have long presented a significant landslide 
hazard to the A83 trunk (strategic) road that traverses the slope to the Rest and be Thankful 
car park and connects large parts of mid-Argyll with the Central Belt of Scotland.  

The A83 leading to the Rest and be Thankful has been subject to a number of closures in 
recent years due to landslide activity (McMillan & Holt 2018; Wong & Winter 2018; Winter 
et al. 2019). Such closures have led to the development of significant management and 
mitigation options (Anon. 2013; Winter 2016a: Winter et al. 2013, 2019; Winter & Shearer 
2017) at the site and these are planned to continue (Winter & Corby 2012; Winter 2016b). 
In particular significant work has been undertaken to monitor the slope above the A83 at 
this location (Sparkes et al. 2018; Winter et al. 2017). 

The work presented here builds upon the work and methodology presented by Winter et al. 
(2017) to collate time-series very high resolution photographic imagery and panoramic 
imagery (the individual images and the panorama are retained for inspection). The 
equipment and software used by Winter et al. (2017) comprised that which was readily 
available to prove the concept, efficacy and usefulness of collecting such imagery. For the 
current work equipment and software specific to the task was acquired making higher 
resolutions possible and ensuring a greater degree of both reliability and precision in the 
capture of the imagery. 

In particular a 50.6 mega-pixel DSLR with a high quality 200mm lens was used for the data 
acquisition, which as Winter et al. (2017) calculated yields pixel densities of around 1,000 to 
26,000/m2 at the sites considered herein. In addition an automated panoramic head was 
used rather that a manual device, greatly increasing the usability of the equipment, along 
with software specifically developed to stitch high resolution images. 

The methodology is described in Section 2 and the stations at which imagery was captured 
are detailed in Section 3. Section 4 details the results acquired along with sample images, 
while Section 5 presents a short discussion and conclusion. 

Appendices A and B describe the setup of the panoramic head and the camera/lens 
respectively while Appendix C details the station locations and capture parameters, and 
Appendix D describes the processing of the images. 
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2 Methodology 

2.1 Major Items of equipment  

Camera 

 Canon EOS 5DS DSLR (full-frame, 50.2MP): 
https://www.canon.co.uk/for_home/product_finder/cameras/digital_slr/eos_5ds/ . 

 Canon EF 200mm f2.8L USM MkII Lens:  
https://www.canon.co.uk/lenses/ef-200mm-f-2-8l-ii-usm-lens/. 

 Canon tripod Mount Ring AII (B). 

Panoramic Head 

 GigaPan Epic Pro V: http://gigapan.com/cms/manuals/epic-pro-introduction.  

Tripod 

 Gitzo Tripod Series 3 Systematic 3 4S XL. 

 Gitzo Systemic 3 Levelling Base. 

 Gitzo ½ Bowl 75mm Video Adapter Systemic Series 2-4 GS3321V75. 

Software 

 Canon Digital Photo Professional version 4.2.30.0 

 Adobe Digital Negative Converter 10 

 PTGui Pro Version 10.0.17 

2.2 Image Capture  

At each set-up position the location (see Section 3) was determined using a non-differential 
GPS unit and records and descriptions of the previously used positions. The GPS was used to 
gain approximate position (typically reporting accuracy to between 2m and 5m) in cases of 
doubt and the descriptions of positions along with peg markers to home in on the precise 
positions.  

The tripod and panoramic head were levelled in three stages. After the initial set-up of the 
tripod (generally with two  of four legs extended, but see Appendix C) the level bubble on 
the tripod was approximately centred using the leg adjustments, after which the video bowl 
was adjusted to centre the built-in level bubble. Finally after the panoramic head was 
attached the video bowl was again used to level the centre bubble on the panoramic head 
itself.  

Before placing the camera on top of the Gigapan panoramic head, the focus was set 
manually by using autofocus mode and then immediately switching to manual focus (MF). 
Focus was typically on a point between the A83/Old Military Road however the objective 
was to maximise the areas of the hillside that were in focus and therefore sharp in the 

https://www.canon.co.uk/for_home/product_finder/cameras/digital_slr/eos_5ds/
https://www.canon.co.uk/lenses/ef-200mm-f-2-8l-ii-usm-lens/
http://gigapan.com/cms/manuals/epic-pro-introduction
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resulting images. The principles of hyperfocal distance1 were used although it should be 
noted that this was complicated by the fact that the lens, as is typical with modern lenses, 
has a maximum focus distance mark of 10m prior to infinity; in practice this should not be 
an issue at f/4 or above which attracts a near-focus of less than 400m at the hyperfocal 
distance of 750m. 

Once the focus was set a series of exposure and white balance readings were taken across 
the relevant position of the hillside. From these average exposure and white balance 
settings were set. Exposure was set at ISO200, f/8 (or f/11 in bright conditions) and the 
shutter speed set to ensure a balanced exposure for the entire hillside. Using f/8 or f/11 
maximises image quality.  

The camera was then fitted to the GigaPan panoramic head using a lens ring mount, the 
camera was connected to the GigaPan panoramic head with a remote release cable that 
allows the GigaPan to trigger each exposure automatically and in the correct vertical and 
horizontal orientation. In order to determine the top left and bottom right corners of the 
panoramic image for input to the GigaPan, bearings were taken using a sighting compass 
and the inclination was noted from the scale marks on the GigaPan. Clearly these values 
varied for each set-up position.  

Menu settings that were been previously entered and saved into the GigaPan’s memory 
were used for all set-up positions (see Appendix A); these include settings that are specific 
to the camera and the lens combination used. The camera was set to Manual Mode, with 
manual focus (MF) set on the lens and with two second Mirror Lock-up set to minimise 
vibration. The Shutter Length and Pre-trigger Delay settings on the GigaPan (see Appendix A) 
are also optimised to minimise the vibration and to allow the optimum time for any 
vibrations to disperse.  

Selecting the option for a New Panorama triggers the start of the image capture process and 
top-left and bottom-right the panorama are first selected as described above. The GigaPan 
goes through a checklist process prior to automatically capturing the images.  

This process was repeated for each set-up position; the images for each location/capture 
were stored to a separate folder on the memory cards (both CF and SD cards were used) 
within the camera in order to make the organisation of the images easier.  

  

                                                      

1
 Photopills was used to calculate the near focus and hyperfocal distances 

(http://www.photopills.com/calculators/dof).    

http://www.photopills.com/calculators/dof
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3 Stations and Locations 

The sites generally follow the locations set-out by Winter et al. (2017) with some key 
differences. The station locations are described in the following paragraphs and illustrated 
in Figures 1 (A83) and 2 (A85). The locations are defined in Table 1, while more detailed 
instructions for locating the stations are given in Appendix C. 

 

Figure 1. Locations of stations at the A83 Rest and be Thankful. Note that Stations A83 
RabT Pano2a and A83 RabT Pano2b, and A83 RabT Pano3a and A83 RabT Pano3b are 

sufficiently close together that only one can be identified clearly on the map. (Image mot 
to scale, based on OS 1:25,000 mapping. © Crown Copyright. All rights reserved Scottish 

Government 100020540, 2019.) 

Stations A83 RabT Pano2a and A83 RabT Pano2b (and RabT 1, as used by Winter et al. 2017) 
are located in the area of the survey station and first data logger adjacent to the forest track 
in Glen Croe that is reached from the car park for Ben Donich. Station RabT 1 has not been 
used in the work presented here as tree growth has rendered the view from this location 
less favourable. 

Stations A83 RabT Pano3a and A83 RabT Pano3b are located further (south) down the forest 
track (after taking the left/lower fork) in the area of the second data logger adjacent to the 
track. 
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The A83 RabT Pano2a and A83 RabT Pano2b, and A83 RabT Pano3a and A83 RabT Pano3b 
stations were paired in order to include the potential future use of stereographic 
photogrammetry. 

Station A83 RabT Pano4 is located close to the telecommunications mast adjacent to the 
B828 while A83 RabT Pano5 is located adjacent to a telecommunications mast on the flanks 
of Ben Donich. Imagery was collected at this site, which is of much higher elevation than the 
other sites only when the time available and cloud cover made it possible to do so 
effectively. 

A83 RabT Pano6 was added in a newly deforested area in High Glencroe. 

 

Figure 2. Locations of stations at the A85 Glen Ogle. (Image not to scale, based on OS 
1:25,000 mapping. © Crown Copyright. All rights reserved Scottish Government 

100020540, 2019.) 

The two sites at Glen Ogle (A85 GO Pano1 and A85 GO Pano2) are adjacent to the old 
railway line and imagery was captured during periods of inclement weather that rendered 
work at the A83 site impossible.  
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Table 1. Locations from which panoramic imagery was captured. 

Location  
(Current Work) 

Location  
(Winter et al. 2017) 

National Grid 
Reference (NGR) 

Start 
Bearing1 (°) 

End 
Bearing (°) 

Start 
Inclination 

(°) 

End 
Inclination 

(°) 

No Rows  
× 

No Columns 

Not Used RabT 1 NN 23161 06555 
(223161 706555) 

- - - - - 

A83 RabT Pano2a RabT 2 NN 23167 06553 
(223167 706553) 

350 075 20 -10 8 × 13 

A83 RabT Pano2b Not Used NN 23170 06548 
(223170 706548) 

350 085 20 -10 8 × 13 

A83 RabT Pano3a Not Used NN 23563 06104 
(223563 706104) 

350 085 20 -10 8 × 14 

A83 RabT Pano3b RabT 3 
(approximate) 

NN 23571 06090 
(223571 706090) 

350 085 20 -10 8 × 14 

A83 RabT Pano4 RabT 4 
(approximate) 

NN 22968 07162 
(222968 707162) 

020 130 20 -10 8 × 15 

A83 RabT Pano5 RabT 5 NN 22964 06382 
(222964 706382) 

355 100 15 -20 9 × 15 

A83 RabT Pano6 Not Used NN 22965 06820 
(222965 706820) 

000 125 20 -10 8 × 17 

A85 GO Pano1 GO 1 NN 57127 26353 
(257127 726353) 

360 100 20 -10 8 × 14 

A85 GO Pano2 GO 2 NN 57417 26140 
(257417 726140) 

025 070 20 -10 or -20 8 × 8 or 10 × 9 

1 
All bearings are direct from compass reading and are not corrected for magnetic north. 
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4 Results 

The extent of the imagery data captured during this contract is significant. Tabulated sites 
and the available data are set-out in Table 3 and the full data set comprises around 3TB 
(terabytes) of files.  

For convenience and completeness data captured as part of a previous Transport Scotland-
supported Natural Environment Research Council (NERC) grant (Winter et al. 2017) is 
included. This latter includes the imagery captured in May 2016 and September 2016. 
Imagery captured for 2017 to 2019 (under this contract) was for all stations (A83 RabT 
Pano2a, 2b, 3a, 3b, 4 and 6) while capture at the higher altitude A83 RabT Pano5 station 
was restricted to those site visits when the weather, in particular cloud cover, was 
favourable. Imagery at Glen Ogle (A85 GO Pano1 and A85 GO Pano2) was captured only 
when weather conditions at the A83 site precluded image capture and it was not viable to 
break off site visits. It should also be noted that the October 2018 post-event imagery was 
captured under slightly different contractual arrangements. 

The type of imagery that can be captured is illustrated as panoramas in Figure 3 to 11 for 
each of the nine stations at the A83 Rest and be Thankful and A85 Glen Ogle sites. These 
panoramas are generally for October 2018 post-event captures, but earlier in May 2018 for 
A83 RabT Pano5 and earlier in October 2018 for the A85 Glen Ogle stations. 

Figure 12 is a detail from one of the 104 original images that were used to form the A83 
Glen Ogle Pano2a panorama (Figure 3) and the level of detail that can be clearly seen is 
described in the associated figure caption.  
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Table 2. Imagery captured prior to and as part of this contract 

Location  
 

2016-05 2016-09 2017-11 2018-05 2018-10 
(pre-events) 

2018-10 
(post-events) 

2019-04/05 Report 

RabT 1 ✔ ✔ ✘ ✘ ✘ ✘ ✘ Winter et al. 
(2017) 

A83 RabT Pano2a 
(RabT2) 

✘ ✔ ✔ ✔ ✔ ✔ ✔ Winter et al. 
(2017) 

A83 RabT Pano2b ✘ ✘ ✔ ✔ ✔ ✔ ✔ Current 

A83 RabT Pano3a ✘ ✘ ✔ ✔ ✔ ✔ ✔ Current 

A83 RabT Pano3b 
(Rabt3) 

✘ ✔ ✔ ✔ ✔ ✔ ✔ Current 

A83 RabT Pano4 ✘ ✔ ✔ ✔ ✔ ✔ ✔ Current 

A83 RabT Pano5 ✘ ✔ ✔ ✔ ✘ ✘ ✔ Current 

A83 RabT Pano6 ✘ ✘ ✔ ✔ ✔ ✔ ✔ Current 

A85 GO Pano1 ✘ ✔ ✘ ✘ ✔ ✘ ✔ Current 

A85 GO Pano2 ✘ ✔ ✘ ✘ ✔ ✘ ✔ Current 
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Figure 3. High resolution panoramic image for Station A83 RabT Pano2a for 2019-10 post-event (image dated 30 October 2018) 
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Figure 4. High resolution panoramic image for Station A83 RabT Pano2b for 2019-10 post-event (image dated 30 October 2018) 
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Figure 5. High resolution panoramic image for Station A83 RabT Pano3a for 2019-10 post-event (image dated 30 October 2018) 
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Figure 6. High resolution panoramic image for Station A83 RabT Pano3b for 2019-10 post-event (image dated 30 October 2018) 



High Resolution Panoramic Imagery   

 

 

Issue 1 6 PPR908 

 

Figure 7. High resolution panoramic image for Station A83 RabT Pano4 for 2019-10 post -event (image dated 30 October 2018) 
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Figure 8. High resolution panoramic image for Station A83 RabT Pano5 for 2018-05 (image dated 24 May 2018) 
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Figure 9. High resolution panoramic image for Station A83 RabT Pano6 for 2019-10 post-event (image dated 30 October 2018) 
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Figure 10. High resolution panoramic image for Station A85 GO Pano1 for 2018-10 (image dated 3 October 2018) 
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Figure 11. High resolution panoramic image for A85 GO Pano2 for 2018-10 (image dated 3 October 2018)
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Figure 12. Sample of one of the 104 original images that form the A83 RabT Pano2a 2010-
30 post-event panorama (Figure 3) illustrating the ability to capture detail. Fresh evidence 
of debris flow can be seen to the left of the picture and the loss of material can be seen to 
the left of the channel while evidence of nascent levee structures can be seen to the right 

of the channel. Individual clasts of a few centimetres to 10 centimetres can be clearly seen. 
To the right of the picture evidence of past/older movement is clear with evidence of 

revegetation in the scar being clearly visible. The image is resolved at 66.7%, 300ppi and  
measures 19.71cm by 11.37cm (image filename: A83 RabT Pano2b-2 2018-10-

30_054A4878.TIF; image dated 30 October 2018) 
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5 Discussion and Conclusions 

The panoramic imagery described in this report has proven its worth in a number of ways. It 
has assisted in identifying the type of movement that has been successfully isolated using 
LiDAR and  Transport Scotland’s consultants are actively using the imagery in reporting the 
construction works currently ongoing at the A83 Rest and be Thankful. In addition, it is 
currently proposed that the imagery will be a primary data source for a survey to determine 
the hazard from boulders that currently reside on the SW-facing slope of Beinn Luibhean. 

Perhaps more importantly a time-series of imagery is provided through a period of relative 
quiescence and before and after significant events such as those of October 2018. The 
October 2018 survey coincided with the period just before these events (Figure 13) and the 
opportunity was taken to undertake further surveys as soon as possible after the events, 
thus providing very useful before-and-after imagery (Figure 14). It is clear from Figures 13 
and 14, even at the highly reduced resolution presented here, that even quite subtle 
differences can be readily discerned from the before and after images. 

The contractual arrangements for the current series of image capture are now completed 
and it is recommended that alternative arrangements be sought to ensure that the imagery 
continues to be captured on a nominal biannual basis with provision for additional capture 
immediately after major events. This fits well with the emerging Transport Scotland plans 
for future monitoring at the A83 site. 
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Figure 13. Central section of the A83 RabT Pano2a 2010-30-02 (pre-event) image showing 
the SW-facing slope of Beinn Luibhean prior to the failures of 9 October 2018 
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Figure 14. Central section of the A83 RabT Pano2a 2010-30-30 (post-event) image showing 
the SW-facing slope of Beinn Luibhean and the failures of 9 October 2019 
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Appendix A Setup of GigaPan Epic Pro V 

The images and text below illustrate the basic setup of the GigaPan Epic Pro V. The 
dimensions shown on the vertical and horizontal scale adjusters are important but it should 
be noted that these are specific to the Canon EOD 5DS and Canon EF 200mm f2.8L USM 
MkII camera and lens combination. 

 

 

  

GigaPan physical positions:  

Horizontal 75mm 

Vertical 72mm 

 

 

GigaPan Menu Settings: 

Camera set up: 7.1 vertical degrees 

Time/Exposure: 3 seconds  

Multi picture: 1 

Brackets: 1(normal) 

Mirror lockup: off 

Shutter Teach: off 

Start Del/Trig: None 

Pic-order: row-down  

Time-lapse/series: Disable 
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Expert Option 

Checklist: On 

Shutter mode: Remote 

Shutter Length: 3.0 seconds 

Motor speed: Slow 

Motors rigid: off 

Pre-trigger delay: 3.0seconds 

 

 

Bracket delay: 1.5 seconds 

Backlight mode: Power save 

Auto off timer: 5min 

Aspect ratio: 3:2 

Picture Overlap: 35% 

Optimize pan: On 

Shutter feedback: off 
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Appendix B Camera/Lens Setup  

Camera settings:  

Mirror Lock-up: 2s. 

Fully manual operation (focus, exposure, white balance). 

Exposure:  

 ISO = 200 (lower values preclude the use of Digital Lens Optimiser, DLO);  

 Aperture/F Number = f/8 or, in bright conditions, f/11;  

 Shutter set to a value to give a representative exposure across the slope. 

 White balance: depending on conditions (typically ‘cloudy’ or ‘sunny’). 

Manual focus: on A83/Old Military Road. 

Camera set to capture RAW image files (JPEG as a back-up) to enable adjustments to the 
exposure and other settings during post-processing. Post-processing undertaken using 
Canon Digital Photo Professional 4 (download). 

The camera/lens is always mounted on the GigaPan EpicPro V using the lens mount. 
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Appendix C Station Setup and Capture Parameters 

C.1 A83 RabT Pano2a 

Location:  
8m south of centre line of survey plinth at 
the edge of the road. 
NN 23167 06553 (223162 706552) 
resolved on map as NN 23165 06553. 

 

 

Coverage: 
Bearings: 350° to 075°. 
Inclination: up 20° down -10°. 
Rows: 8; columns: 13. 
Time: 18m 18s for 104 pics. 
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C.2 A83 RabT Pano2b 

Location:  

11m south of centre line of survey plinth 
at the edge of the road. 

NN 23170 06548 (223169 706548) 
resolved on map as NN 23170 06548. 

 

Coverage: 

Bearings: 350° to 085°. 

Inclination: up 20°; down -10°. 

Rows: 8; columns: 13. 

Time: 18m 22s for 104 pics. 
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C.3 A83 RabT Pano3a 

Location: 

0.6m away (at approximately 45°) from 
corner of survey station plinth on the 
outside (NE) corner.  

NN 23563 06104 (223563 706104) 
resolved on map as NN 23570 06104. 

 

 

Coverage: 

Bearings: 350° to 085°.  

Inclination: up 20°; down -10°. 

Rows: 8; columns: 14. 

Time: 19m 46s for 112 pics. 
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C.4 A83 RabT Pano3b 

Location: 

4.5m south of SW corner of survey station, 
1.5m in from edge of forest track/pin.   

NN 23571 06090 (223571 706090) 
resolved on map as NN 23571 06099. 

 

Coverage: 

Bearings: 350° to 085°  

Inclination: up 20°; down -10° 

Rows: 8; columns: 14. 

Time: 19m 46s for 112 pics. 
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C.5 A83 Pano4 

Location:  

East of telecommunications mast adjacent 
to B828. 

NN 22968 07162 (222968 707162). 

 

Coverage: 

Bearings: 020° to 130°. 

Inclination: up 20°; down -10°. 

Rows: 8; columns: 15. 

Time: 22m 10s for 120 pics. 
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C.6 A83 Pano5 

Location: 

2.5m east downslope of SE corner of 
compound. 

NN 22964 06382 (222964 706382).  

 

Coverage: 

Bearings: 355° to 100°.  

Inclination: up 15°; down -20°. 

Rows: 9; columns: 15.  

Time: 20m 27s for 135 pics. 
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C.7 A83 Pano6 

Location: 

Bearing 247° Pano6 to mast at top of 
forest track. Tripod centred on top of/to 
rear of outcrop. 1.4 m in front of peg with 
red ribbon (towards Beinn Luibhean).  

NN 22965 06820 (222965 706820) 
resolved on map as NN 22965 06820. 

 

 

Coverage: 

Bearings: 000° to 125°  

Inclination: up 20° down -10° 

Rows: 8 columns: 17; Time = 23m 59s for 
136 pics 
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C.8 A85 GO Pano1 

Location: 

2m south of end of viaduct railing immediately butted up against wall. (Note use 2.5 
sections of tripod rather than the usual 2.) 

NN 57127 23353 (257127 726353). 

Coverage: 

Bearings: 360° to 100° . 

Inclination: up 20°; down -10°. 

Rows: 8; columns: 14. 

Time: 19m 46s for 112 pics. 
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C.9 A85 GO Pano2 

Location: 

Just before/to N of large boulder/outcrop on east side of old railway line. Location is about 
1m N of fifth short fence post from boulder (there are two taller posts adjacent to the 
boulder that are not counted). (Note use 2.5 sections of tripod rather than the usual 2.) 

NN 57417 26140 (257417 726140). 

Coverage: 

Bearings: 025° to 070° . 

Inclination: up 20°; down -10° or up 20°; down -20°. 

Rows: 8; columns: 8 or Rows: 10;  columns: 9. 

Time: 10m 20s for 64 pics or Time: 14m 12s for 80 pics. 
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Appendix D Image Organisation and Processing  

Templates have been set up for folders <DN>, <DN-DNG>, <DN-Edit>, and <TIFFs> for each 
panoramic image.  

The RAW (*.CR2) files are first transferred to the <DN> folder (JPEG images are for backup 
purposes only).  

The folder names for the panoramic images follow the style:  

 <A83 RabT Pano# YYYY-MM-DD 5DS 200 mm> 

 

Rename and organise record files for processing 

Canon Digital Photo Professional version 4.2.30.0 

For each panorama: 

• Create a folder for each panorama in the format <A83 RabT Pano# YYYY-MM-DD 5DS 
200mm>. 

• Create subfolders: <DN>, <DN-DNG>, <DN-Edit> and <TIFFs>. 
• Select-all images and place in the <DN> folder. 
• Start renaming tool > run to rename images: <A83 RabT Pano# YYYY-MM-DD_Original file 

name> 
• Copy all images to <DN-Edit>. 

Adobe Digital Negative Converter 10  

For each panorama: 

• Make versions of the original RAW files, from the DN folder, for storage in *.dng format 
these are stored in <DN-DNG>. (*.dng is a long-term stable digital negative format that is 
independent of the equipment used for capture.) 

Process images and create TIFF files 

Digital Photo Professional version 4.2.30.0 

For each panorama (process only the images in DN-Edit): 

• <DN-Edit> -> View -> Select all images -> Tool Palette.  
• Apply any necessary corrections to the images (Exposure, Shadows, Highlights, 

Contrast and Colour Saturation). 
• Apply correction for lens.  
• Note that it is essential that the same corrections are applied to all images. 

• Close Digital Photo Professional (or select a different folder) and select ‘Yes to all’ to save 
the changes to all images.  

• Re-open Digital Photo Professional (or select the original <DN-Edit> folder) 
• <DN-Edit> -> View -> Select all -> File -> Batch Process -> Use a different folder -> TIFFs 

-> save type Exif-TIFF 8bit, output res 300ppi -> Execute 
• Digital Photo Professional can now be closed. 
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Create Panoramic Images 

PTGui Pro Version 10.0.17 

For each panorama: 

• Project assistant 
• Load Images -> Select all TIFF files 

• Project 
• Align to grid -> Apply 

• Panorama Editor, wait for panorama to render 
• Align Images 
• Panorama Editor -> Cylindrical (Note: The shape of the resulting panorama may need to 

be adjusted to rectilinear by toggling and pulling the centre-point of the image and then 
Edit -> Fit Panorama, this process may need to be followed repeatedly) 

• Create Panorama (Blended Panorama Only) 
• Select -> save it to folder to make the default storage location <A83 RabT Pano# YYYY-

MM-DD 5DS 200mm> 
• Create Panorama (ensure throughout that quality is set to 100%, especially for JPEG 

and MOV files) 
• Native, this is the size that the program defaults to (JPEG, TIFF) 
• Optimum size (Photoshop large file, *.PSB; QuickTime file, *.MOV:) files are 

generally larger than allowed for either JPEG or TIFF, these files are for future-
proofing purposes 

• Dimension in pixels of 65,500 px2 (JPEG), the largest size of JPEG allowed  
• TIFF at largest size possible, start at 65,500 px and if necessary reduce the px 

dimension to conform to the maximum 4Gb file size (also make a JPEG)3 
• TIFF at largest size possible but less than 2Gb file size (a limit for some software). 

There is no need to make a JPEG unless it is radically different to the ‘Native’ file 
created above*  

• Dimension in pixels of 30,000 px (JPEG, TIFF), the largest size of JPEG file that many 
programs will open 

The file names should be <A83 RabT Pano# YYYY-MM-DD #####>, where ##### represents 
the parameters of the panoramic images (these are detailed above and the shorthand text 
used should be based on inspection of the filenames used in the work reported here). 

Between each different panorama check and change as necessary the destination and name 
of the output files in <Output file destination> (under Create Panorama). 

  

                                                      

2
 The dimensions given in pixels (px) are for the maximum dimension, (i.e. width for images with a landscape 

aspect and height for those with a portrait aspect. 

3
 Note that the software estimates the file size and typically the outturn files are considerably smaller. 
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Managing Hazardous Slopes 
 

This report details a project to capture time-series panoramic imagery over a two-year period at 
the A83 Rest and be Thankful site, which is highly susceptible to rainfall-induced debris flow. This 
builds on a previous proof-of-concept project and the available data is reported for both projects in 
order to present as complete a picture as possible. Imagery from the A85 Glen Ogle site, captured 
on an opportunistic basis, is also reported. The data has been used in a variety of ways in support 
of other monitoring and construction reporting activities at the A83 site and its use is planned in a 
survey to determine the hazard from boulders that currently reside at the A83 site. The time-series 
imagery provides effective before-and-after imagery for major events and its continued capture 
and use is recommended. This report sets out the process and procedures for the capture and 
creation of high resolution imagery in order to enable the time-series to be continued and for the 
methodology to be applied to other sites. 

Other titles from this subject area  

PPR 636  A83 Rest and be Thankful: ecological and related landslide mitigation. M G Winter & A Corby. 2012. 

PPR 824 Landslides triggered by Storm Desmond at the A83 Rest and be Thankful, Scotland: panoramic 
photography as a potential monitoring tool. M G Winter, B Sparkes, S A Dunning & M Lim. 2017. 

PPR 852 Monitoring and modelling of landslides in Scotland: characterisation of slope geomorphological activity 
and the debris flow geohazard. B Sparkes, S A Dunning M Lim & M G Winter. 2018. 

PPR 798 The quantitative assessment of debris flow risk to road users on the Scottish trunk road network: A83 
Rest and be Thankful. J F C Wong & M G Winter. 2018. 

TRL 

Crowthorne House, Nine Mile Ride, 
Wokingham, Berkshire, RG40 3GA, 
United Kingdom 
T: +44 (0) 1344 773131 
F: +44 (0) 1344 770356 
E: enquiries@trl.co.uk 
W: www.trl.co.uk 

ISSN 2514-9652 

ISBN 978-1-912433-91-9 

PPR908 

mailto:enquiries@trl.co.uk

